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Get Started with the CSP 
This chapter contains the following topics: 

 
Register for the CSP 

Self-register at supplier.coupahost.com, get an invitation email from Lear, forward an invitation to a peer, or create an 

account from a Lear PO email. 

 
Create Your Account 

After receiving an invitation, create your CSP account. 

 
Log in to the CSP 

See how to log into the CSP using single or two-factor authentication. 

 
Enable or Disable Two-Factor Authentication 

Enable two-factor authentication for additional security. 

 
Manage Your Account 

Change your personal information, set your notification preferences, or enable/disable two-factor authentication. 

 
Create or Update Your Profiles 

Update your public and customer-specific company profiles. 

 
Navigate and Get Help 

Learn where to find what in the CSP, including help. 

 
View and Manage Notifications 

View your notifications and set your notification preferences. 
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Register for the CSP 
You have the following options to register for the CSP: 

 

Method Benefits Considerations 

Customer-created 

invitation 

You get a Lear invitation with specific 

instructions and a proactive message. 

When you accept the invitation and create 

your account, you are automatically 

connected/linked to Lear. 

You have to wait for your Lear contact to 

send the invitation email. This means that 

you might not get invited due to your contact 

forgetting or not having the time to send the 

invitations to all their suppliers. 

Self-created invitation You can set up your accounts ahead of time, 

add multiple users, set up your login 

preferences, and update your profile more 

quickly. 

You need to connect manually to Lear in 

Coupa. Let your Lear Buyer contact know that 

you have registered and you want to connect 

with them. 

Lear can connect with you through their 

Supplier Portal Directory, or by sending an 

invitation email to any of the CSP supplier 

users on the account. However, if you are 

invited using a different email, that email can 

log in but will have to merge with the account 

that was set up ahead of time in order for all 

the supplier users to be on the same account 

and linked to Lear. 

Purchase order (PO) 

email 

Lear does not have to proactively manage 

invitations and reminders for you to get 

connected through the CSP. 

 

You can create a CSP account without 

requiring an invitation if you receive 

electronic Coupa PO today. 

 

None 

Forwarded invitation 

from a coworker 

You can easily invite others within your 

organization to the CSP by forwarding them 

your PO email notification or by sending them 

an invitation from the create account page. 

You end up with the right supplier user(s) 

linked to and transacting electronically 

through the CSP with less work. 

You can forward the invitation only to email 

addresses with the same domain. However, 

this ensures more built-in security. 

 
With all methods, you need access to the email address you are going to use for the account. 

 
Your CSP account is based on a specific email address. If you use an email address different from the one Lear currently 

have on file for you, you cannot connect until you give Lear the updated email address. 

 

 



 

 
 

5 
 

 
 

Tip: If you do not receive your invitation email, check your spam folder. 

Note: For the new email format, only Microsoft Outlook version 16 is supported. 

Customer-created invitation 

Ask your Lear Buyer contact to send you an invitation to the CSP. 

 

 
 
 

Self-created invitation 

Go to supplier.coupahost.com and by clicking Sign Up, fill in the fields of Work Email Address and Company Name, 

and then click Sign Up to request an invitation. 

 
 

In both cases, you receive an email invitation with a different subject line, depending on whether the invitation was sent 

by Lear or was initiated by you. 

 

If the email was initiated by Lear, it contains Lear’s logo instead of the Coupa logo. 
 

 

The email contains instructions and links to useful information, and buttons for joining the CSP or forwarding the 

invitation.  
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Warning: You can forward the invitation only to email addresses with the same domain. 

Warning: Invitations to the CSP expire after 30 days. 

Forwarded invitation 

You can invite others to the CSP by forwarding them your PO email notification with the Create Account button, by 

clicking on the Forward This button in your CSP invitation email, or by sending them an invitation from the create 

account page. 
 

 

An invitation to the CSP is sent to the email address that you specified. 

 
When the invited user clicks on the Join Coupa button in the email, the user is directed to create an account to 

the CSP. 

 

If the user is already linked to the CSP or tries to create an account from an expired invitation, the user is directed to the 

Register / Login page where a red message bar displays the following: "Your invitation has expired or already been 

activated." 
 

 

Create Your Account 
Join the CSP 

After following the link from an invitation email (other than Lear-created invitation), fill in the mandatory fields to provide 
basic information for your account and your company's public profile. 
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Note: If you join the CSP from one of two simultaneous invitations received from your administrator and your 

customer, you might see a green box with a question asking whether you are an employee of the supplier 

organization and you need to select either the Yes – Join or No – Create New Account checkbox. 

Setting Description 

*First Name Your personal first name to be applied to your personal account. 

*Last Name Your personal last name to be applied to your personal account. 

*Company The name of your company as seen on your company's public profile. 

*Department The name of your department: Sales, Operations, Accounts 

Receivable, Treasury, or Other. 

*Role Your role within the department: 
 

• Sales: Sales Manager, Sales Associate, Proposal Manager, Other 

• Operations: E-Commerce Manager, Order Fulfillment/Inventory 
Management, Other 

• Accounts Receivable: Accounting Manager, Accounts Receivable Associate, 
Other 

• Treasury: Treasury Manager, Other 

• Other: Enter free text. 

 
Tip: If you select Other for Department and/or Role, the User Specified 

Department and/or User Specified Role fields are displayed for you to 

enter free text. 

*Email This field cannot be changed. If you want to change your email address, you have 

to create a different CSP account using the new email address. If you also want 

to use this email, create two company accounts and merge them. For more 

information, see Manage Merge Requests. 

*Password Use this field to create your password. It must be at least 8 characters long, and it 

has to include a number and a letter. 

*Password Confirmation This field needs to match the password you typed in the password field. 

 
 

 

Welcome message 

 

When you join the CSP from a Lear invitation, you can see a registration page that is different from the page shown 

above. The Create your business account page contains the following welcome message and company logo by 

default.  
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Tip: You can update your information later on the My Account Settings page. For more information, see 

Manage Your Account. 

 
 

You need to enter password and accept the Privacy Policy and the Terms of Use. You can get help to sign up or you can 

forward the invitation to others by clicking on the relevant links. 
 

 

By default, this account is the admin account for your company. Once set up, you can add users and assign them roles, 

including account administration. For more information, see Administer the CSP. 

 

Forward your invitation 

You can invite others any time by entering their email address in the Forward email field in the Forward your 

invitation section and clicking Submit, or by clicking on the Forward this to someone link if you see the welcome 

message. 

 

For more information, see Register for the CSP. 

 
 

Log in to the CSP 

Login page 

Go to supplier.coupahost.com and in the Log in tab, enter your email address and password and click Log In. 
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Multiple active sessions 

You cannot have more than three active sessions simultaneously. When you log in to another session, you are forced to 

close an open one. A message notifies you that you have too many active logins and you will be signed out from one of 

your other sessions if you click Log In. You can also Cancel the attempt to log in to another session. 

 

 

Inactivity 

Your account is deactivated automatically if it is inactive for a defined period of time, that is, if: 

 
• You have not logged in to the CSP for more than 90 days. 

 
• You have not verified your account for 6 months. 

 
You receive an email notification with the subject "Your CSP Account is Inactive." To keep your account active, you 

need to log in to the CSP. 

 

When you try to log in as an inactive user, a red message bar notifies you of the verification email you received. To 

reactivate your account, you need to confirm that email. On the CSP login page, a green message bar informs you of 

the successful email verification and you can log in. For more information, see Log in to the CSP. 
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Note: If you log in from a new Lear invitation, the welcome tour is shown after the welcome message, and 

you can also access it from the Help menu (in the top right corner) > Help Tour. For more information, see 

Navigate and Get Help. 

Welcome message 

When you log in for the first time from a new Lear invitation, you can see the following welcome message and 

company logo by default.  

 
 

 
 
 

Welcome tour 

Once you are signed in, Coupa takes you on a welcome tour. 
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You can skip the tour by clicking on the Skip button or closing the window with the X in the top right corner. Clicking 

Next takes you to the second page of the tour, which provides you with basic information on the benefits of invoicing 

through the CSP. 

 

 
By clicking on the relevant link, you can go directly to view the Orders, Invoices, or Admin pages, or go to the next tour 

page that provides basic information about how the CSP can help you transact and communicate with Lear, for example, 

by allowing you to manage your catalogs, orders, and invoices, and setting notification preferences for   

important transactions. 
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The fourth (last) page of the tour summarizes the additional features, for example, the possibility to provide supplier 

information through the CSP, update POs with advance ship notice (ASN), update catalog items, and features for 

payments, such as, managing payment settings (Lear have not implemented all of these Coupa functions at the moment). 

If you click on the Go to Online Help to Learn More link, you are directed to the Coupa Supplier Portal Admin and User 

Guide for details on each feature. 
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Note: In Lear’s instance, two-factor authentication is not a mandatory requirement. It’s at supplier’s own 
discretion to enable this function or not. 

Note: The code is good only for 60 seconds. If you do not type that code on the CSP sign-in page and click 

Log In within 60 seconds, you have to get a new code and try again. 

Two-factor authentication 

When you log in for the first time, you could be prompted to enable two-factor authentication. For more information, see 

Enable or Disable Two-Factor Authentication. 

 

 
 

 

Log in with two-factor authentication 

If you have enabled two-factor authentication, the Two-Factor Authentication window opens when you want to log in to 

the CSP. 

 

If you enabled the Two-Factor Authenticator App, choose open Google Authenticator on your device, choose your 

CSP account, and get the validation code. 

 

If you enabled two-factor authentication for SMS, check your text messages to get the verification code. 

 
Type the two-factor authentication code in the appropriate field, choose Remember this computer for 30 days if you  
are not using a shared or public computer, and click Log In. 
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Note: If you are locked out and you do not have your six-digit backup validation code, contact Lear system 

admin team who will ask for a declaration form sent from your email used to log in to the CSP to verify your 

identity.  

Note: In Lear’s instance, two-factor authentication is not a mandatory requirement. It’s at supplier’s own 
discretion to enable this function or not. 

Note: If you want to receive SMS notifications or verification codes, you must enter and validate your phone 

number under Mobile Phone Verification. 

For more information, see Enable or Disable Two-Factor Authentication. 
 

 

Enable or Disable Two-Factor Authentication 
On the My Account page, click on the Security and Two-Factor Authentication link to enable or disable two-factor 

authentication. 
 

 

 

 
 

Enable two-factor authentication 
 

 

Under Two-Factor Authentication, click Enable for SMS or for Two Factor Authenticator App depending on how you 

want to receive the verification codes. 

 

• For SMS, enter the verification code in the pop-up window. 
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After successful validation, you receive the verification codes in text messages. 

 
• For installing and using Google Authenticator, follow the on-screen instructions. 
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Note: You can only use a recovery code once, so refresh your list if you have to use a recovery code. Go to 

Account Settings > Security & Two-Factor Authentication and click Regenerate Recovery Codes to get 

a new list of codes. 

Choose Remember this computer for 30 day if you are not using a shared or public computer, and click Enable. 

 
Print your backup codes or email them to yourself before you click OK. If you ever lose your device, you need these to regain 
access to your CSP account. 

 

 

 

Disable two-factor authentication 

Under Two-Factor Authentication, click Disable for SMS or for Two Factor Authenticator App and, in the appearing 

window, enter your CSP password and click Disable Two-Factor Authentication. 

 
If you enable or disable two-factor authentication, you get an email notification of the change. 
 

Supported Languages in the CSP 
 

The Coupa Supplier Portal (CSP) user interface is available in several languages. When accessing the CSP, you can 

select different language and region combinations. 

 

Change languages 

To change the CSP UI language, select the language picker at the bottom of the page and choose your preferred 

language and region.  
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Note: You can access and edit you company information on the Profile page. 

Manage Your Account 
On the My Account Settings page, you can make changes to your personal information (name, department, role, and 

password), set or modify your notification preferences, or enable/disable two-factor authentication. 
 

To change your account settings, click on your name link and on the Account Settings link. 

 

 

Personal information 

On the appearing My Account Settings page, fill in the fields you want to change, and then click Save. The asterisk (*) 

indicates mandatory fields. 
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Setting Description 

User Details 

*First name This is your personal first name. 

*Last name This is your personal last name. 

*Email This field cannot be changed. If you want to change it, you have to create a new 

CSP account and connect it to your company. For more information, see Manage 

Users. 

Department The name of your department: Sales, Operations, Accounts 

Receivable, Treasury, or Other. 

Role Your role within the department: 
• Sales: Sales Manager, Sales Associate, Other 
• Operations: E-Commerce Manager, Order 

Fulfillment/Inventory Management, Other 

• Accounts Receivable: Accounting Manager, Accounts Receivable 
Associate, Other 

• Treasury: Treasury Manager, Other 

• Other: Enter free text. 

 

Tip: If you select Other for Department and/or Role, the User Specified 
Department and/or User Specified Role fields are displayed for you to 
enter free text. 

Change Password 

*Current Password Your current password. 

*Password Use this field to change your password. It must be at least 8 characters long 

and it must include a number and a letter. 

*Password Confirmation This field needs to match the password that you typed in the Password field. 

 

Click on the Notification Preferences link to set or modify your notification preferences. For more information, see 

View and Manage Notifications. 

 

Click on the Security & Two-Factor Authentication link to enable/disable two-factor authentication. For more 

information, see Enable or Disable Two-Factor Authentication. 

 

Create or Update Your Profiles 
In the CSP, you have a public profile and you can have specific profiles for each customer that you are connected with 

through the CSP. 

 

You can view and update your public and customer-specific profiles from the Home page or the Profile page. 
 

Update your public profile 

Anyone can find and connect with you through your public profile. 
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Your public profile is created when you create your account and it contains general information about your company, for 

example, name, logo, website, industry, year of establishment, top commodities, currencies, diversity, and corporate 

social responsibility rating (on the Home and Profile / Public Profile pages), the link to your public profile (on the Home 

page), and contact information (on the Profile / Public Profile page). 

 

 
 

Profile progress 

At the top of the Home page, you can see your profile progress/completeness. 

The following table shows the profile completeness stages. 

Profile Progress Bar Color Message 

Red Action needed: Complete your profile to get paid faster and get discovered. 

Blue Recommended: Complete your profile to get paid faster and get discovered. 

Green Great job! A complete profile helps you get paid faster and get discovered. 

 

Next to the progress bar, the Last Updated field shows how long ago the profile was updated, for example, 2 minutes 

ago or 10 days ago. 

 
The following table shows the color of the progress bar depending on the age of the profile. 
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Percentage of 

Completeness 

Last Updated < 1 Year 

Ago 

Last Updated 1-2 Years 

Ago 

Last Updated > 2 Years 

Ago 

< 50% Red Red Red 

50% - 80% Blue Blue Red 

80% - 100% Green Blue Red 

 
The Learn More link next to the profile progress message opens the Get Discovered with a Complete Public Profile 

popup with tips and information on the benefits of a complete public profile. 

 

 
Clicking Update Profile opens your public profile for editing. 
 

Profile summary 

Under the section about your profile progress, you can see an actionable profile summary, which shows the number of 

legal entities and registered users based on the information provided in your profile, and the number of connected users, 

that is, the number of customers linked to your profile. 

 

Clicking on the View link under Legal Entities takes you to the Admin / Legal Entity Setup page where you can add, 

update, or deactivate legal entities. 

 

Clicking on the View link under Registered Users directs you to the Admin / Users page where you can invite new or 
manage existing users. 

The profile summary also indicates if you have ( ) or have not ( ) provided banking and diversity information, if you 

accelerate orders/invoices, and if you have a bribery policy. 
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Note: If all the support agents are offline or busy, you can Send a support request through an offline form 

in the same chat window. 

Tip: If you are logged in to the CSP, your contact information is pre-populated, but you can modify it. 

Navigate and Get Help 

Help 

Contact Lear Coupa System Admin Team 

Email to CoupaSupplierAsia@lear.com This is the Lear system administration team that can help you on your questions 

relating to transacting with Lear in CSP. They can cover questions mainly on the technical side. And if it more 

business/commercial related, it’s better to reach out to your Lear Buyer/Plant contacts. 

Contact Coupa Support (This is Coupa as a company, not Lear) 

1. Chat with Coupa Support 

Whether you are logged in to the CSP or not, you can chat with Coupa Support (from Coupa Company) to get a quick 

response or resolution to your case. Click Chat with Coupa Support in the bottom right corner of the page to launch the 

chat. 

 
 

 

Provide your contact information: first name, last name, email address, and phone number (optional).  

Start chatting with the support agent 
 

mailto:CoupaSupplierAsia@lear.com
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Note: If no support agent is available, you also need to provide the subject of your request and a detailed 

issue description, after which you can see a confirmation that your case was submitted and logged. A support 

agent contacts you as soon as they are available. 

Tip: After the chat ends, you can save the transcript. Note: Your account and login information is not stored and support agents cannot log in to your CSP. 

However, information provided in the chat is logged, so do not provide unnecessary personal information. 

          
 

 

If the support agent asks you to send a file, a paperclip icon appears on the left of the field where you type your message. 

 

 

When you browse, the chat window persists on all the pages except for your Public Profile page, and you can minimize 

it by clicking on the opposite arrows icon in the top left corner. 
 

The chat is available also when accessing the CSP from a mobile device. 
 

2. Online Help, Blog, and Help Tour 
 

When you log in for the first time, you are greeted by the Help Tour (welcome tour) on the Home screen. 

 
Click on the Help link in the top right corner of the page to view the Help Tour any time.  
 
You can also use the Blog and Online Help links to learn more about the CSP. 
 

  



 

 
 

24 
 

 
 

Note: IE browser is already end of life. Try not to use IE but other browsers like Chrome or Edge.  

Main menu 

To access a CSP function, click on the relevant tab on the main menu at the top of the CSP main page. 

 

 
 

Menu Item Description 

Home View and improve your public company profile, see the list of customers you are 

connected to, edit your customer-specific company profile, and merge accounts. 

You can go to the Home page from any page by clicking on the coupa supplier 

portal logo/link in the top left corner above the main menu. 

Profile Create, modify, and manage your public and customer-specific profiles, and 

specify which remit-to addresses each customer can use. 

Orders View the purchase orders you received from your customers. 

Service/Time Sheets View the list of service/time sheets and related purchase order lines. 

ASN Send advance ship notice, that is, notifications about when you ship items to your 
customers. 

Invoices Create and manage invoices to send to your customers. 

Catalogs Create and manage customer-specific catalogs. 

Payments Accept payment through digital checks from your customers if they use Coupa Pay. 

Business Performance View a summary of orders and invoices that may need attention, your year-to- date 
order and invoice trends, and your lead time to shipping goods. 

Add-ons Access Coupa supplier add-ons, for example, Coupa Advantage, Coupa 
Accelerate, supplier profile update, and more. 

Setup Manage users, merge requests, and remit-to addresses, set up electronic 
invoicing, add fiscal representatives, view and accept the Terms of Use, and set 
preferred accelerated payment terms. 

 

 

 

View and Manage Notifications 
Hover your cursor over the Notifications link to see your unread system notifications. Only the three most recent 

notifications are shown. 

https://success.coupa.com/Suppliers/For_Suppliers/Coupa_Supplier_Portal/Administer_the_CSP/07_Terms_of_Use
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To view all the notifications with their details and to manage them, click on the Notifications or the See All 

Notifications link. 

 

 
On the My Notifications page, you can view all your (read and unread) notifications, or you can filter by category (FYI, 

To-do, Unread, or Announcements). You can select and delete them all or one-by-one. 

 

Clicking on a notification link takes you to the relevant page. 

 
To change your notification preferences, click on the Notification Preferences button in the top right corner. Or click on 

your name link and on the Notification Preferences link. 
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Note: You cannot disable online notifications for announcements. 

You can access the notification preferences also from your Account Settings. For more information, see Manage Your 

Account. 

 

On the My Account Notification Preferences page, select the radio buttons for the items that you want to receive any 

or all of the notification types: online (to do list), email, or SMS (short text message). You will start receiving notifications 

when your customers enable them. 
 

SMS notifications are turned off by default. 

 
If you turn SMS notifications on, but you disable mobile phone verification, your SMS notification selections are deleted. 

You can also stop receiving SMS notifications if you reply STOP. 

 

Setting Description 

Announcements 

New Customer Announcement Enabled by default: Online and Email 

Business Performance 

Business Performance role granted Enabled by default: Online 

Catalogs 

A new comment is received Enabled by default: Online and Email 

A catalog is approved Disabled by default. 

A catalog is rejected Disabled by default. 

A catalog is about to expire Disabled by default. 

Coupa Accelerate 

New Early Pay Customer Enabled by default: Online and Email 

Coupa Pay – Available only if your customer uses Coupa Pay and enabled the related features. 

New digital check Enabled by default: Online and Email 

New virtual card Enabled by default: Online and Email 

Virtual card reissued Enabled by default: Online and Email 

Virtual card reminder Enabled by default: Online and Email 

Payment role given to user Enabled by default: Online and Email 

Virtual card processing failure Enabled by default: Online and Email 

Bank transfer remittance advice Enabled by default: Online and Email 

Virtual card remittance advice Enabled by default: Online and Email 
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Setting Description 

Zero payment remittance advice Enabled by default: Online and Email 

Digital Check Cancelled Enabled by default: Online and Email 

Virtual Card Cancelled Enabled by default: Online and Email 

Early Payments – Available only if your customer enabled the feature. 

Early payment request expired Enabled by default: Online and Email 

Early payment request rejected Enabled by default: Online and Email 

Early payment request matched Enabled by default: Online and Email 

Early payment request paid Enabled by default: Online and Email 

Form Responses 

A form response is approved Enabled by default: Online and Email 

A form response is rejected Enabled by default: Online and Email 

Supplier information is updated Enabled by default: Online and Email 

A new comment is received Notifies you if your customer sends you a new comment or a reply to your 

question/comment regarding a Supplier Information Management (SIM) form 

request/response. 

Enabled by default: Online and Email 

A form response needs your attention Enabled by default: Online and Email 

Integration Errors 

Enable notification for integration error Disabled by default. 

Invoices 

A new comment is received Enabled by default: Online and Email 

An invoice is approved Enabled by default: Online and Email 

An invoice is paid Enabled by default: Online and Email 

An invoice is disputed Enabled by default: Online and Email 

An invoice is withdrawn from dispute Enabled by default: Online and Email 

Legal Invoice Export Ready Enabled by default: Online and Email 

An invoice is abandoned Enabled by default: Online and Email 

Orders 

A new comment is received Enabled by default: Online and Email 
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Note: If you change your notification preferences, remember to save them. 

Setting Description 

A new order is received Enabled by default: Online and Email 

An order is canceled Enabled by default: Online and Email 

Order Header Changes 

Order change request is rejected Enabled by default: Online and Email 

Profile 

Public profile is updated Disabled by default. 

An information update request is 

received 

Enabled by default: Online and Email 

Profile update reminder is received Disabled by default. Future functionality. 

Update information requests Disabled by default. Future functionality. 

Receipt Request 

Receipt created Disabled by default. 

Terms of Use 

New Terms of Use are received Enabled by default: Online and Email 

Users 

A new customer connection is created Enabled by default: Online and Email 

Service/Time Sheets 

A Service/Time Sheet is 

approved 

Enabled by default: Online and Email 

A Service/Time Sheet is rejected Enabled by default: Online and Email 

 
 

You also receive notifications displayed in a green bar following certain actions, for example: 
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Administer the CSP 
 

This chapter contains the following topics: 

 
Admin Page 

The admin page lets you manage merge requests, set up your legal entity, remit-to addresses, and more. 

 
Manage Users 

Manage user permissions and customer access. 

 
Manage Merge Requests 

Merge accounts and manage merge requests. 

 
Set up Legal Entities 

Set up your account by adding legal entities to be able to create e-invoices. 

 
View and Manage Remit-to Information 

Provide remit-to information to meet compliance regulations when invoicing. 

 
Terms of Use 

View and sign the terms of use to work with the CSP. 

 
Create Custom Views 

Change the view settings depending on how you want to see information on orders, invoices, catalogs, 

service/time sheets, ASNs, or payments for each customer. 
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Admin Page 
On the Admin page you can manage users and merge requests, and the remit-to addresses for your customers; you 

can set up legal entities and fiscal representatives; you can view and sign the terms of use, etc. 

 

 

 

Menu Item Description 

Users Invite new users, and manage what each user can do in the CSP and which customers your 

users can interact with. 

Merge Requests Manage any merge requests that you sent to or received from other supplier accounts. 

Legal Entity Setup Set up your account for electronic invoicing. 

Fiscal 

Representatives 

Add fiscal representatives that you need if you have operations in a country/region where you 

are not registered legally but you need to be represented for tax purposes. 

Remit-To Create and manage multiple remit-to addresses that are used to determine the payment 

location for invoices. This is important for creating legally compliant invoices. 

Terms of Use To use the Coupa Supplier Portal (CSP), you must accept the terms of use. 

Payment Preferences 

/ Static Discounting 

Set preferred payment terms (early payment discounts terms) to be applied to any of your 

customers across all your invoices. 

SFTP Accounts Create and manage SFTP accounts to load invoices quickly. 

cXML Errors Get cXML error notifications and view the list of cXML errors to ensure timely correction and 

better handling of cXML transmission failures. 

SFTP Errors View the list of SFTP (CSV) file upload errors to ensure timely correction and better handling 

of SFTP transmission failures. 
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Manage Users 
Permissions grant access for users to corresponding menu items. As an admin user, you have all the permissions by 

default. 

 

You can manage user permissions and customer access by assigning certain users to only certain customers and by 

limiting what types of documents they can access and what functions they can perform with their assigned customers. 

 

Go to Setup > Admin. The Admin Users page appears. 

 

 
Click on the Edit button to open the Edit user access for [User Name] window. 
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You can change the user's name, modify the user's permissions and customer access, or deactivate the user. 

 

You cannot change the user's email address. If a user wants to change the email address, send a new invitation to that 

user. 

 
The Invite User and Edit user access for [User Name] windows are almost identical, but when you invite a user, you 

can specify an email address. 
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Note: All users, regardless of permissions, can edit the public profile. 

User permissions 

Permissions Description 

All Gives full access to all CSP functions, except for user administration. 

Admin Has full access to all CSP functions, including user administration. Non-admin 

users can still view the Users tab of the Admin page and invite users, but they 

cannot edit existing users. The permissions on the invitation cannot exceed the 

permissions of the user creating the invitation. 

Orders Allows viewing and managing purchase orders (POs) received from customers. 

When selected, All is on by default. 

Restricted Access to Orders Allows accessing specific POs (assigned to specific users). The permission is off 

by default. 

All Allows viewing and managing all POs received from customers. When Orders is 

selected, it is on by default. 

Invoices Allows creating and sending invoices to customers. 

Catalogs Allows creating and managing customer-specific electronic catalogs. 

Profiles Allows modifying customer-specific profiles. 

ASNs Allows creating and sending advance ship notices (ASNs) to customers. 

Service/Time Sheets Allows creating and submitting service/time sheets against POs. When selected, 

All is on by default. 

Restricted Access to Service/ 

Time Sheets 

Allows accessing specific service/time sheets (assigned to specific users). The 

permission is off by default. 

All Allows creating and submitting any service/time sheets against POs. 

When Service/Time Sheets is selected, it is on by default. 

Payments Allows viewing payments and downloading digital checks. 

Order Changes Allows submitting PO change requests. 

Pay Me Now Available only if your customers use Coupa Pay and enabled the feature related 

to this permission. 

Business Performance Allows viewing business performance information, for example, order, invoice, 

and delivery trends. 

Sourcing Allows viewing public sourcing events. 

 

The Info ( ) icon tooltip shows the following information: 

 
Permissions grant access for the user to the corresponding menu items. 
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Note: For auditing purposes, Coupa does not allow users to be deleted, so you cannot delete a user from 

your profile. Instead, you can deactivate a user when you no longer want that user to be able to access the 

account. 

For Orders and Service/Time Sheets, an additional level of granularity allows restricting a user’s access to documents 

that are specifically assigned to them. If you want to apply this restriction, select the Restricted Access to Orders and 

Restricted Access to Service/Time Sheets permissions. 
 

 

Reactivate users 

You can deactivate users when necessary. Also, users are deactivated automatically due to inactivity. For more 

information, see Inactivity. 

 

You can see the relevant user status: inactive or deactivated. If you hover over a user's status, the following tooltip text 

is displayed informing you about the reason why a supplier user is not active: 

 

• Deactivated: This user has been manually deactivated by an admin. It can be reactivated only by admin 

reactivation. 

 

• Inactive: This user's account has been deactivated due to inactivity. It can be reactivated by validating the user's 

email during their next login attempt. 

 

You can activate both inactive and deactivated users. If you activate them, they receive an email notification to verify 

their email. 

 

If you deactivate users, you can always reactivate them later. If you reactivate a user, the customer access is reset for 

that user, so you'll have to assign customers to that user again. 

 

Manage Merge Requests 
Your company may have more than one account/profile in the CSP. This can happen when several users from the same 

company register or are invited to the CSP through different email addresses. 

 

The suggestions to merge accounts are based on email domain. For example, all the users with the @example.com 

domain get suggestions to merge. Merge suggestions appear in the right-hand column on the Home page. 

https://success.coupa.com/Suppliers/For_Suppliers/Coupa_Supplier_Portal/Get_Started_with_the_CSP/07_Log_in_to_the_CSP#Inactivity
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If you know that a suggestion is invalid, click on the Remove button and you will not see the request again. 
 

If you want to merge an account, click on the Request Merge button and select an account to be the parent account and 

add a note. 

 

When you select either your account or the other account to be the account owner, the CSP shows you a visual 

representation of who controls what data after the merge. 
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Selection Description 

*Account Owner / My Account This causes the other account to be merged into your company account. The 

other user's company account is removed. 

You continue to be the administrator for the merged company account, and the 

previous administrator becomes a regular user in the merged account. You can 

make them an administrator if you want. For more information, 

see Manage Users. 

*Account Owner / Their Account Your company account is removed. The other user's company account becomes 

the only company account. 

You can no longer be the account administrator, but the administrator of the 

existing account can choose to make you an administrator of the merged account. 

*Note Add a note about the merge request, for example, the reason for the account 

merge. 

 

Merged accounts use the following rules: 
 

Element Merge Behavior 

Connected customers and 

customer profiles 

Any connected customers are retained in the new account. The existing email 

address remains the contact email for the customer. If the customer is connected 

to both accounts, the parent account connection is retained and the merged 

account connection is removed. 

Remit-to addresses Remit-to information is transferred only for addresses that are available to all 

customers. 

 
You can also search for a specific account to merge, for example, if the account is not listed or the list is too long to 
search for the specific account that you want. Clicking on the Click here link takes you to the Admin Merge Requests 

page. You can access this page also by clicking on the Admin tab on the main menu and on the Merge Requests link 

on the left. 
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Provide the email address of the account you want to merge, and click Request Merge. You can search up to five times. 

 
You can see purchase orders and create invoices for both supplier records after selecting a customer from the Select 

Customer drop-down. 

 

Set up Legal Entities 
You can set up your account to create electronic invoices from the Admin / Legal Entity Setup page. You can add, 

manage, or deactivate legal entities, or manage remit-to accounts. 

 

You can provide more remit-to accounts and add this information to your legal entities so that your customers can use 

different payment methods when working with you. 

 

View and manage legal entities 

On the left of the Admin page, click on the Legal Entity Setup link. 

 

 

 
If you have three or more legal entities, they are collapsed. To view their details, click on the Down arrows. 

Each legal entity has the following sections: 

• Invoice From 

• Remit-To Accounts – Can be of type: Address, Bank Account, or Virtual Card. 

• Locations 

• Customers – The name(s) and number of customers that you provided with the specific legal entity are also shown. 
Hovering your cursor over n customers displays the name(s) of the customer(s) associated with the legal entity. 
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Tip: Include this information on the invoice when the 

addresses are different. For many countries, including this 

information is mandatory. 

Tip: You can add legal entities also from the Profile edit page directly or when creating an invoice. 

See Create or Update Your Profiles and Create or Edit an Invoice for more information. 

Create a legal entity 

To add a legal entity, click on the Add Legal Entity button in the top right corner. 
 

 

Enter the official name of your business that is registered with the local government (legal entity name) and select the 

country/region where it is located. Click Continue, and in the appearing Tell your customers about your organization 

window, fill in at least the mandatory fields, that is, the fields marked with a red asterisk (*). 

 

Field/Checkbox Description 

Which customers do you want 

to see this? 

Select all or the specific customer(s) that you want to see your legal entity 

information. 

Customers that use Coupa for payments are marked with the Coupa Pay ( ) 

icon. 

If you select a Coupa Pay customer, the payment information that you enter is 

validated. The icon and tooltip are different depending on whether your banking 

information is: 

 
• Valid:  

• Invalid:  

• Pending validation:  

What address do you invoice 

from? 

Required for invoicing. Is critical for compliance in some countries. 

Registered address of your legal entity. This is the same location where you 

receive government documents. It might differ from the physical address. 

Sometimes this is called your address of record or registered company address. 

Address line 1, city, and postal code are mandatory. 

Country/Region The country/region you selected when adding the legal entity. 

Use this address for Remit-To* Selected by default. Deselect it if your remit-to address is different from your 

invoice-from address or you have more than one remit-to locations. 

Use this for Ship From address* Selected by default. Deselect it if your ship-from address is different from your 

invoice-from address or you have more than one location. 
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Tip: You can add more tax IDs by clicking on the Add additional 

Tax ID link. 

Note: If you are exempt from tax registration in some regions/countries, 

select the I don't have TAX ID Number checkbox and enter your local tax ID 

or write N/A in the appearing Local Tax ID field. 

Note: You can see these options and provide your information, but Lear does not use Coupa Bank Account 

or Virtual Card information and the details you mention here is only for-information. If you want to update 

your bank account details in the Lear payable system, please contact your Lear counterpart (buyer, AP 

team). 

Field/Checkbox Description 

What is your Tax ID? Enter your tax/VAT ID. 

Country/Region Select your tax country/region from the drop-down list. 

Tax/VAT ID Enter the tax/VAT ID, including the prefix to the number, for example, 

GB1234567890. 

Fiscal Rep If you selected a different country than that of your legal entity in the 
Country/Region selector in this section, you need to designate a fiscal 
representative who is authorized to do business in that country/region on your 
behalf. For more information, see Add Fiscal Representatives. 

I don't have a TAX ID Number Select the checkbox to add your local tax ID or write N/A in the Local Tax ID field. 

Miscellaneous 

Invoice from Code Tie your CSP invoice-from address (that is, registered address) with the 

corresponding address in your ERP. 

Preferred Language Select your language from the drop-down list. 

 

*If your remit-to and ship-from addresses are different from your invoice-from address, you need to provide also that 

information. 

 

After filling in the fields, click Save and Continue. In the appearing Where do you want to receive payment? window, 

select from the following payment types: Address, Bank Account, and Virtual Card. 
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Note: The banking information provided during the Coupa Registration is optional, this information is NOT 
automatically transferred to Lear’s Corporate Payment System. If you need to update your Bank Account 
detail please reach out to your Lear Purchasing Buyer. 

 

If you select Address (default option), you can continue to the next step as you already provided the address(es) on the 

previous page. 
 

If you select Bank Account, you can provide your banking information to be shown on your invoices. 
 

 

The Where do you want to receive payment window shows both the Remit-To Account and the Remit-To Address. 
 

 
 

To manage your legal entities, click on the Actions button on the Legal Entity Setup page, select Manage Legal 

Entity, and click Continue. In the appearing Where do you want to receive payment window, you can add a new 

remit-to address. 
 

You can deactivate a legal entity by selecting Deactivate Legal Entity from the Actions button or on any of the 

appearing windows. 
 

Click Next to add the address where you want to ship goods from, if it is different from the remit-to address. Fill in at 

least the mandatory fields and click Continue. 
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After completing the legal entity setup by clicking Done, that is, after adding a legal entity, you can use it on new 

invoices. From the Setup Complete page you can choose to Go to Orders, Go to Invoices, or Return to Admin page. 

 
 

 
 

To manage your remit-to accounts, go to Setup > Admin > Remit-To. For more information, see View and Manage 

Remit-to Information. 

 

View and Manage Remit-to Information 
Remit-to addresses ensure global electronic invoice compliance. To meet compliance regulations for most countries 

outside of the US, an invoice must include a remit-to address and associated tax information. If you want to do business 

with a customer who enabled compliant invoicing, you need to provide the necessary information. 

 

You are required to add a remit-to address when setting up (adding a legal entity for) electronic invoicing or creating 

invoices. For more information, see Set up Legal Entities and Create or Edit an Invoice. 

 
 

View remit-to accounts 

Go to Setup > Admin > Remit-To to view the list of remit-to accounts and their details: associated remit-to address and 

legal entity, payment type, the (up to five) customer(s) they are assigned to, and possible actions (update, share, and 

disable). 
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Icons in the Customers column indicate the status of the remit-to accounts.  

Column Description 

Customers The customers you've shared this remit-to address with 

(up to five are displayed). The icons indicate the remit-to 

status with the customer they appear next to: 

 
• Active (  ): The remit-to address is active and 

approved by your Coupa customer in their instance. 

 

• Active and Pending Validation ( ): The remit-to 
address is active but is pending confirmation in your 
Coupa customer's instance. 

 

• Inactive (  ): The remit-to address is inactive. 
 

• Error (  ): Something happened and you need to 
contact Coupa support. 

 

The most recently added remit-to account is at the top of the list. 

Manage remit-to accounts 

You can add new, or update, share, or deactivate existing remit-to accounts by going to Setup > Admin > Remit-To. 

Add 

To create a new remit-to, click the Add Remit-To button, select the legal entity to be associated with it, and click Next. 
 

You can add remit-to accounts also from the Setup > Admin > Legal Entity Setup page. Click on the Actions button, 
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select Manage Remit-To Accounts, and in the appearing Add a new Remit-To account window, click Add Remit-To. 

 
In the appearing Add a new Remit-To account window, fill in at least the mandatory address fields and select a 

payment type (marked with a red asterisk). 
 

 
 
For more information about the fields, see Set up Legal Entities. 

 

https://success.coupa.com/Suppliers/For_Suppliers/Coupa_Supplier_Portal/Administer_the_CSP/04_Set_up_Legal_Entities
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Tip: Tooltips marked with the Info ( ) icon provide information about the valid format for the fields. 

Note: When you try to save a remit-to account with invalid fields, you can see an error message. You can 

decide to ignore the errors and save the account anyway; however, it is not recommended as it may result in 

delayed processing for the affected customer(s). 

 

You can save an invalid remit-to account only once; later you are required to correct the invalid fields. 

Note: Deactivation cannot be undone, so you are asked to confirm the action. 

Note: After you submit the updated remit-to information, a new remit-to account is created and the original 

account is deactivated. 

If the selected payment type is Bank Account, you can see fields for bank account details that are relevant to the 

selected bank account country/region. Bank account fields are validated.  

If you enter an invalid format in a field, the field is highlighted in red and information about the expected format is 

displayed in red text under the field. 

 

Click Save and Continue. The new remit-to account is added to the list. 
 

 

Invalid remit-to accounts are marked with red in the Customers column and a tooltip provides details about the error. 

 

Deactivate, Update, or Share 

To deactivate a remit-to account, click Manage in the Add a new Remit-To account window, and then click Deactivate 

 
Remit-To. You can deactivate remit-to accounts also from the Admin / Remit-To page by clicking the Disable ( ) 

icon in the Actions column. 

 

Deactivating a remit-to account also deactivates the corresponding supplier payment account on your Coupa Pay 

customer side. If the deactivation is unsuccessful, you are informed about it in a message bar. 
 

 

Click the Update ( ) icon to update remit-to information, for example, to correct invalid fields. 
 

 

You can share your remit-to accounts with some or all customers. Click the Share ( ) icon and in the appearing Edit 

Remit-To Usage window, select the customer(s) from the Add Additional Customers drop-down list, and click Add 

Selected. To share it with all your customers, select Add All from the Add Selected drop-down. 
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Note: If you merge accounts, your remit-to addresses are not merged unless you make them available for 

all customers. Once the merge is complete, you can assign the remit-to address to the specific customer(s) 

again. 

 
 
 

 
 

Terms of Use 
To use the CSP and to allow Coupa to create invoices on your behalf when you use compliant e-invoicing, you must 

sign the Coupa Open Business Network legal Terms of Use. Otherwise, you cannot create and submit invoices through 

Coupa and the CSP. 

 

The legal terms of use lists the terms and conditions for using e-invoicing through Coupa and the CSP. You as a 

supplier, especially if you are responsible for managing legal tax invoices, are required to have read, assessed, and 

agreed to these terms of use and to be aware of your responsibilities towards the content and handling of these 

invoices. 

 

To issue a legal compliant invoice, you need to set up a remit-to address for a compliance country. When you use a 

compliance country remit-to address for the first time, Coupa validates if you have signed the latest terms of use. 

 

If the Terms of Use has not been signed yet or there is an updated version of the Terms of Use, you are prompted to 

review and sign it. You can use the embedded link to review and sign the legal terms of use. 
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Or review the latest version from the bottom menu of the CSP 

 

 

 

Create Custom Views 
 

You can create custom views for orders, order lines, order changes, order line changes, service/time sheets, service/ 

time sheet lines, advance ship notices (ASN), invoices, catalogs, invoice payments, and PO payments. 
 

With a custom view you can create a set of advanced search filters. 
 

1. On the main menu, click on the tab for the function for which you want to create a custom view. 
 

2. At the top of the table whose view you want to change, click Create View in the View drop-down list. 
 

3. On the Create New data table view page, select the customer for whom you want to change the view settings, 

and then specify the settings you want to use for your custom view, including filtering conditions, columns to 

include, and sorting criteria. 
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If you want to build this view based on another view and modify those settings, use the Start with view option under 

the General settings. 
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You can use the following settings when creating or editing a custom view for a CSP table. 

 

Group Setting Description 

General Name Name of the custom view, visible from the View drop-down list at the top of 

the table. 

Visibility Defines whether this view can be visible to only you or all the other users that 

can see the main table. 

Start with view Use this option to load the settings from another view, and then modify those 

settings to fit your needs for this view. 

Conditions Apply All - Displays results only for objects that meet all of the conditions you add in 

this list. 

Any - Displays results for objects that meet at least one of the conditions you 

add in this list. 

Conditions Create conditions based on the data available in the CSP. 

Columns Available 

columns 

This list depends on the table you work with in the CSP. You can select any 

of these columns to add to your custom view. 

Selected 

columns 

These are all the columns displayed in this custom view. They appear from 

left to right, in the same order that you set them up here. 

Default Sort 

Order 

Choose the column by which you want results to be sorted and define whether to sort them in 

ascending or descending order. 

 

4. Save your settings. 

To delete a custom view, open the view for editing by clicking on the Edit View ( ) icon and click on the Delete ( ) 

button at the bottom of the page. 
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Work with CSP 
This chapter contains the following topics: 

 
View Business Performance Data 

You can view a summary of orders and invoices that may need attention, your year-to-date order and invoice 

trends, and your lead time to shipping goods. 

 
View Customer Announcements 

View announcements from your customers. 

 
View and Manage POs 

View purchase orders received from your customers. 

 
View PO Lines 

View individual PO lines by going to Orders > Order Lines. 

 
Create or Edit an Invoice 

Work with existing invoices or create new invoices without a backing PO. 

 
View and Manage Invoices 

View and edit invoices that you sent to your customers. 

 
View Invoice Lines 

View individual invoice lines by going to Invoices > Invoice Lines. 

 
Payment Information on the Invoice 

View Payment information by going to Invoices > View Payment Information or the Payments layout on each invoice. 

 
Disputed Invoices 

View and resolve disputed invoices by going to Invoices > View Disputed.  
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Note: You can see this page only if you have the Business Performance permission. For more information, 

see Manage Users. 

View Business Performance Data 
Click on the Business Performance tab on the main menu to view a summary of orders and invoices that may need 

attention, and year-to-date order, invoice, and delivery time trends. 
 

 

View the order/invoice summary dashboards 

In the top left corner, select from the list or search for the customer for which you want to see performance data. 

 

 

 
The selected customer name appears at the top of the page and below it, you can see a summary (with numbers and 

statuses) of your orders and invoices that need attention as follows: 
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Tip: To see the description for a status, hover your cursor over the relevant number. 

Note: The View links are visible only if you have permission to view orders/invoices. 

Note: The data provided is directional and for informational purposes only, and may be delayed up to one- 

two weeks. 

    Document Type Status Description 

Orders 

 
Past Due For an issued order, if the "need by date" has passed and the order is not 

complete. 

Not Acknowledged The number of orders that you have not acknowledged. Shown only if you 

acknowledged at least one order in the past. 

Change Requested Orders for which you or your customer have requested a change. 

Not Invoiced Orders that you have not invoiced yet. 

Invoices 

 
Pending Approval Invoices that have not been approved by your customer yet. 

Unpaid Coupa Pay customer invoices that have not been paid yet. 

Overdue Invoices that have not been paid yet and are past the due date. 

Disputed Invoices that you or your customer have marked as disputed to indicate an 

invoice discrepancy. 

 

 

Clicking on the View links takes you to the Orders or Invoices page, respectively, showing only the list of orders/ 

invoices relevant to the status selected to view. 
 

 

 

View order/invoice/delivery time trends 

Below the summary dashboards, you can find graphs for order, invoice, and delivery time trends for the past 12 months. 
 

 

The order/invoice graphs show the volume/amount and count/number of your orders/invoices by month. 
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Hover your cursor over Volume or Count in the legend to highlight the relevant data. 

 

 

 
Hovering your cursor over the volume bar or count line shows you the volume or count of orders/invoices by month. 
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Delivery time trends show the average delivery days (time in days between the order date and the receipt date) and the 

number of orders delivered by month. Hover your cursor over the graph to see details. 
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Cases when data or customer is missing 

• If no data is available, for example, there are no orders or invoices with the selected customer, the We could not 

find any relevant (order/invoice) data message is displayed. 

• If you have no transactions (orders or invoices) with a customer, the Before we can show you any cool stuff we 

need you to get some orders and invoices in here! message is displayed. 

• If you are not connected to any customers, the following message is displayed: You need to be connected to 

your customer before we can show you any cool stuff. Ask your customer to send you an email invitation 

from Coupa. This document explains the steps they need to take. It's super easy. The This document link 

takes you to the page where you can learn how to add and connect with a customer in the CSP. 

 

Learn more and provide feedback 

In the top right corner below the list of customers, you can find the Learning Center and Feedback sections. Click on 

the following links: 

 

• Add a customer to learn how to add and connect with a customer in the CSP. 

 
• Want to get paid earlier? to learn about payment options. 

 
• Tell us what you think to provide feedback and suggestions to Coupa. 

 

 

 
The Submit button is enabled only when you enter text in the Your message field. After submitting your message, 

a green notification bar informs you about Feedback sent. 
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Note: By default, only previews of the two most recent announcements are displayed. You can see the full 

text of an announcement in a popup after clicking on it. To view all the announcements with their full 

message, click on the View All (n) link that takes you to the My Notifications page filtered by 

Announcements. For more information, see View and Manage Notifications. 

View Customer Announcements 
Lear can create announcements to be shown to you on the Home page and/or other Coupa Supplier Portal (CSP) pages 

to help you understand unique onboarding requirements and communicate with you about initiatives, promotions, and 

changes required for your collaboration through the CSP. With this one-way communication, Lear can, for example, 

provide you with instructions on how to join or what to do after joining the CSP, share with you information necessary for 

transactions, inform you about upcoming orders, remind you of updating supplier information, and more. 

 

You can see your customers' announcements at the top of the right section of the Home page. 

 

 
 

 

The announcements are also shown where all the other notifications appear, that is, in the Notifications and My 

Notifications sections. 
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Note: You cannot disable online notifications for announcements. Customers' announcements are always 

shown on the Home and My Notifications pages for the set period of time. 

 
 
 

Online notifications are on by default. 
 

 

Depending on your notification preference settings, you can also get online and/or SMS notifications. 

 
If your customer selected other pages to inform you about their announcements, you can see a yellow banner at the top 

of those pages notifying you about the number of announcements for those specific areas from the selected customers 

and the link from which to access those announcements. 

 

 

 
The banner is not visible on the Home, customer-specific Profile view, Admin, and Add-ons pages, and on the Public 

Profile page accessed from the link under the Public Profile section on the Home page. 

 

Clicking View All Announcements directs you to the My Notifications page filtered by Announcements. For more 

information, see View and Manage Notifications. 

 

Your customers can delete or edit their announcements. Deleted and expired announcements disappear from the CSP. 

Also, if you delete a notification for an announcement, the announcement disappears from the Home page, too. 
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Note: Each individual Lear plant is a standalone customer for your account, and when you visit the page again, it 
shows you the invoices for the customer you selected last time. 

View and Manage POs 
Click on the Orders tab on the main menu. The Orders page with the Purchase Orders table appears. 

 
From the Select Customer drop-down list in the top right corner, select the customer whose POs you want to see. 

 

 

The Purchase Orders table shows the following information for all the POs you received from the selected customer. 

 

Column Description 

PO Number PO number generated by Coupa. Click on it to view the PO. 

Order Date Date when the PO was created. 

Status Current status of the PO. For more information, see the PO status list below. 

Acknowledged At Date when you acknowledged the receipt of the PO, or "None" if not 

acknowledged. 

You can choose to let your customer know that you received their PO by selecting 

the Acknowledged At checkbox on the PO. When you select the checkbox, the 

current date appears in the Acknowledged At column. 

This checkbox is a simple toggle, so you can also un-acknowledge an invoice by 

deselecting the checkbox. If you re-acknowledge at a later time, the new date 

appears. 

Items List of items on the PO. 

Unanswered Comments Your comments on the PO for your customer. Also, your customer's comments 

that you need to respond to. 

You can see all your customer's comments or add your comments for the 
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Tip: You cannot reject a PO, but if you do not accept it, you can add a comment on it for your customer. 

 
 
 

You can also print POs. Click on the PO Number link to open the PO and at the end of the PO, click on the Print View 

button. Depending on your browser, click on the three vertical dots or the three horizontal lines icon in the top right 

corner of the appearing window to open the browser menu, and select Print from the list of options. 
 

 

You can filter the table by columns, use the search bar to filter with a search term, or click on the View drop-down list to 

perform advanced filtering. For more information, see Create Custom Views. 

 

POs can have the following statuses: 

 

Status Description 

Buyer Hold The PO is approved but pending buyer review. 

Cancelled The PO is cancelled and does not need to be fulfilled. 

Closed The issued PO was received and then closed, either manually or automatically 

within Coupa. 

Currency Hold The PO is on hold due to a currency exchange rate issue. 

 
 

 

Column Description 

 customer when you open the PO. 

Note: If you need urgent communication, contact your customer directly. 

Total Total amount of the PO. 

Assigned To Contains the email address of the users that have been assigned the Restricted 

Access to Orders and Restricted Access to Service/Time 

Sheets permissions. 

Note: This column is visible only if the Restricted Access to 

Orders and Restricted Access to Service/Time 

Sheets permissions are assigned to at least one user. 

Actions Click on the icons for the following actions: 

 

•  - Create (flip the PO into) an invoice. 

Depending on your customer's settings, the tooltip text can be about creating 

an invoice from the PO or accepting the PO and creating an invoice. 

 

•  - Create a credit note. 

•  - Create a service/time sheet. 

•   - Create (flip the PO into) an advance ship notice (ASN). 

https://success.coupa.com/Suppliers/For_Suppliers/Coupa_Supplier_Portal/Get_Started_with_the_CSP/Create_Custom_Views
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Above the table you can have instructions from the customer specifying, for example, policies or best practices. 

 

Add shipment tracking information 
 

In the Shipment Tracking section in the PO, click on the Add ( ) icon. In the appearing Create Shipment Tracker 

popup window, enter the tracking number for the entire PO, select a carrier (at the moment, only limited couriers’ 

tracking numbers are possible - FedEx, USPS, UPS etc.) from the drop-down window, and add a note (optional). 

 

 

 
 
 

 

View PO Lines 
Click on the Order Lines tab to see information on the PO lines for each PO. 

Status Description 

Error Something is wrong with the PO. Contact your customer to get the PO back on 

track. 

Issued The PO was approved and sent to you. 

Soft Closed The PO is closed but can be reopened. You cannot invoice against a PO in this 

status. 

Supplier Window Hold The PO was approved outside of the order window schedule under contract 

terms. 
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From the Select Customer drop-down list in the top right corner, select the customer whose PO lines you want to see. 
 

The Purchase Order Lines table shows the following information for all the PO lines: 
 

Column Description 

PO Number (Header) PO number generated by Coupa. Click on it to see the PO line. 

Line PO line number. 

Order Status (Header) Current status of the PO. For more information, see View and Manage POs. 

Item List of items on each PO line. 

Total Item Quantity Total quantity of the PO line. 

Line Total Total amount of the PO line. 

 
For your custom view, you can select to see the following additional information: ASN lines, carrier, confirmed quantity, 

delivery date, invoiced, line level text, need by date, received, ship method, ship note, shipment date, shipped quantity, 

and tracking number. 

 

You can export the PO lines table in CSV or Excel format. 

 
You can filter the table by columns, use the search bar to filter with a search term, or click on the View drop-down list to 

perform advanced filtering. For more information, see Create Custom Views. 

 

Create or Edit an Invoice 
From the drop-down list in the top right corner of the Invoices page, select the customer for whom you want to create or 

edit an invoice or a credit note. 

 

Click on the relevant button above the Invoices table to: 

 
• Create Invoice from PO. 

 
• Create Invoice from Contract. 

 
• Create Blank Invoice. 

 
• Create Credit Note. 
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Note: Buttons are active only for the actions that you are allowed to do by your customer. For example, if 

your customer did not enable you to create invoices without a backing document, the Create Blank 

Invoice button is inactive. 

Note: At the top of the page, you might see instructions from Lear. 

 
 

 

The Info icon with the tooltip next to the Create Invoices header advises you what to do if you cannot create an invoice 

as expected, for example, contact your customer to enable more invoicing options for you. 
 

 

 

Create an invoice from a PO 

1. Go to the Orders page or, on the Invoices page, click on the Create Invoice from PO button above the table to 

go to the Orders page. 

 

2. On the Orders page, do one of the following: 

◦ Click on the Create Invoice ( ) icon for the PO in the Actions column of the Purchase Orders table. 
◦ Click on the PO Number link to open the purchase order and click on the Create Invoice button. 
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3. Add new or choose existing invoicing details, that is, add or select an invoice from, remit-to, and/or ship from 

address. 

 

When you select a legal entity, the popup displays the Invoice From addresses available for the legal entity and 

information about how your customer(s) associated with the legal entity can pay you, for example, "This customer 

can pay you by Bank Account or Credit Card." 

 
In case of multiple payment types, you might see multiple Remit-To and Ship From addresses for the different 

payment types. To accept a new payment type, you might need to add a new remit-to type. 
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Note: You are able to bill multiple invoices per PO (partially invoice each time), so do as necessary to modify 
the individual invoice quantity/amount to fit your organization’s invoicing needs. 

 

 

If you do not have a legal entity, you need to add one by clicking on the Add New link or on the add/plus ( ) icon. 

You are guided through creating your legal entity. For more information, see Set up Legal Entities. 

The selected or newly created legal entity is added to your invoice. 

 
4. On the Create Invoice page, fill in at least the mandatory fields (marked with a red asterisk) in your invoice. Some 

of the fields are pre-populated with information from the PO. For more information, see Edit an invoice. 

 

Create an invoice from a contract 

1. Click on the Create Invoice from Contract button above the Invoices table on the Invoices page and select the 

relevant contract from the drop-down list. 

 

 
2. Create a new or choose an existing invoice-from address. See step 3 in Create an invoice from a PO. 

 
3. On the Create Invoice page, fill in at least the mandatory fields (marked with a red asterisk) in your invoice. For 

more information, see Edit an invoice 
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Create a blank invoice 

1. Click on the Create Blank Invoice button above the Invoices table on the Invoices page. 

 
2. Create a new or choose an existing invoice-from address. See step 3 in Create an invoice from a PO. 

 
3. On the Create Invoice page, fill in at least the mandatory fields (marked with a red asterisk) in your invoice. For 

more information, see Edit an invoice. 

 

Create a credit note 

You can issue a credit note to: 

 
• Resolve a dispute on an invoice, correct an invoice, or cancel a duplicate invoice. For more information, see 

Disputed invoices. 

 

• Record miscellaneous credit, for example, return/cancellation of goods, price adjustments, rebates and refunds. 

 
To create a credit note: 

 
1. Click on the Create Credit Note button above the Invoices table on the Invoices page or, on the Orders page, 

click on the Create Credit Note ( ) icon for the PO in the Actions column of the Purchase Orders table. 

2. In the appearing Credit Note popup, select the reason for your credit note. 

 

 
 

◦ Resolve a dispute 

 
If the credit note is related to a problem with an original invoice, select the Resolve issue for invoice number 

radio button and, from the drop-down list, select the invoice number. Click Continue to select how you want to 

resolve the issue. 
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Note: Only quantity or price can be reduced through partial credit notes. 

Note: Header level charges (for example, shipping cost, or header level tax) are not brought over from 

the original invoice. To provide a credit for header level charges, you need to submit a separate stand-

alone credit note. 

 
You can choose to issue a credit note to cancel and optionally correct the invoice or to adjust it. For more 

information, see Disputed invoices. 
 

 

◦ Record a credit 

 
Select Other and click Continue. If a contract is available, you can also select it from the drop-down list. 

 

 

 
Create the credit note similarly to creating an invoice. For more information, see Edit an invoice. 

 
If you completely cancel the invoice, you can edit the following fields: Credit Note Number, Credit Note Date, Supplier 

Note. You can also add attachments (file, URL, or text) and an Image Scan, and modify PO lines, the UNSPSC, and tax 

reason descriptions. The other fields are pre-populated and not editable so that all the information is carried over from the 

original invoice. 

 

If you adjust the invoice, you can also edit the price or quantity. Line level taxes are carried over from the invoice and are 

prorated based on the credit amount. 
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If you selected Other, you are asked to create a new or choose an existing invoice-from address before editing the 

invoice. See step 3 in Create an invoice from a PO. 

 

Edit an invoice 

Fill in at least the mandatory fields (marked with a red asterisk) in your invoice. 

 
If you create or edit a credit note or a PO-backed invoice, some of the fields are pre-populated with information from the 

original invoice or the PO. 

 

Depending Lear’s settings, you will be required to accept the PO and the following restrictions would apply to the 

corresponding invoice: 

 

• Currency – Cannot be changed from PO currency. 

 
• UOM – Cannot be changed from PO line UOM. 

 
• Price – Cannot be changed from PO line unit price. 

 
• Quantity – Can be changed from 0 to the remaining quantity on the PO line. 

 
• Amount – Can be changed from 0 to the remaining amount on the PO line. 

 
These restrictions do not apply to credit notes. 

To edit a draft invoice, do one of the following: 

• Click on the Edit ( ) icon for the invoice in the Invoices table. 

 
• Click on the Invoice # link to open the invoice and click on the Edit button. 
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Fill in at least the mandatory fields (marked with a red asterisk). You can create or choose an invoice from, a remit-to, 
and/or a ship from address by clicking on the corresponding Search (magnifying glass) icon in the From section. You 

are guided through creating your legal entity. For more information, see Set up Legal Entities. 
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You can also attach files to an invoice using Attachment or Image Scan. One attachment can be up to 100 MB, but for 

performance reasons, consider limiting the attachment size to 16 MB or so. Image attachments on invoices must be of the 

following types: PNG, GIF, JPG, JPEG, PJPEG, TIFF, or PDF. 

 
Fill in the appropriate tax rate for your invoice. The tax rate is a government-regulated rate to be paid to the tax 

authorities as part of the sale and it is shown as a percentage. It applies to all commodities sold in a specified 

geographical area. 

 

 
Clicking Calculate will give you the gross total amount considering the tax values. 

 

You can add invoice lines to your invoice by clicking on the Add Line link or the Add ( ) icon next to it. 

Selecting the Line Level Taxation checkbox, allows you to enter tax information for each invoice line. 
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Note: If you want to make changes to the invoice after submitting it, you have to contact your Lear Buyer or 
Accounts Payable team. 

Note: Each individual Lear entity is a standalone customer for your account, and when you visit the page again, it 
shows you the invoices for the customer you selected last time. 

Submit the invoice or save it as a draft to submit it later. You can also add comments on the invoice 
When you try to submit an invoice that does not meet Lear's requirements, you might get the following warning 

message: "This invoice has the following warning(s):", followed by details on what to correct. 
 

Before submitting the invoice, you can cancel or delete it. You can delete only draft invoices. 

 

View and Manage Invoices 
Click on the Invoices tab on the main menu. The Invoices page appears. 

 

 
From the Select Customer drop-down list in the top right corner, select the customer whose invoices you want to see. 

 

The Invoices table shows the following information for all the invoices you sent to the selected customer. 
 

 

Column Description 

Invoice # Invoice number generated by Coupa. Click on it to view the invoice. 

Created Date Date when the invoice was created. 

Status Current status of the invoice. For more information, see the invoice status list 

below. 

PO # PO number generated by Coupa for the order on which the invoice is based. Click 

on it to view the PO. 
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Column Description 

Total Total amount of the invoice. 

If your customers use country compliant invoicing and enabled the relevant field 
setting, on legal invoices (PDFs) you can also see the Totals with Early Payment 
Discount section with discounted totals. 

Unanswered Comments Your comments on the invoice for your customer. Also, your customer's comments 
that you need to respond to. 

You can see all your customer's comments or add your comments for the customer 
when you open the invoice. 

Dispute Reason Your customer's reason for disputing the invoice. 

Actions Click on the Edit ( ) or Delete ( ) icon to edit or delete an invoice. You can edit or 
delete only draft invoices. 

 

 

Invoices can have the following statuses: 
 

Status Description 

Abandoned The disputed invoice has been abandoned. Your customer can choose to notify 

you of this invoice status change and provide instructions. You can set notification 

preferences for abandoned invoices. 

Approved The invoice has been accepted for payment by your customer. 

Disputed The invoice has been disputed. For more information, see Disputed invoices. 

Draft The invoice has been created, but it has not been submitted to your customer yet. 

Invalid Specific for compliant e-invoices for clearance countries, for example, Mexico. It 

indicates that a CFDI (Mexican legal invoice form) that you sent failed validation. 

Invoices with this status are visible only to you, not to your customer. 

Processing The invoice is between invoice being submitted by the supplier and the submission 
being recorded in Lear’s instance 

Pending Approval The invoice is currently under review by your customer. 

Voided Something is wrong with the invoice. Contact your customer to get the invoice 

back on track. 

 
Above the table you can have instructions from the customer specifying, for example, policies or best practices. 

 
You can filter the table by columns, use the search bar to filter with a search term, or click on the View drop-down list to 

perform advanced filtering. For more information, see Create Custom Views. 

 
You can export the invoices table in CSV or Excel format. 

 
If you are from a Coupa e-invoicing compliant country, you can also bulk export all the legal invoice attachments (usually 

PDFs) in a compressed (.zip) file by selecting the Legal Invoice (zip) option from the Export to dropdown. 
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Note: The export usually takes about one minute. In case of a large number of invoices it may take longer. 

Tip: You can set your Invoices table view to show and export your legal invoices by status, created date, 

invoice date, period of time, and so on. 

Warning: If you turn off notifications for this feature, the .zip file is not generated, so you cannot bulk export 

your legal invoices. You can see a warning in the message bar to enable your notifications. 

Note: If you are not logged into the CSP, you are directed to the Login page and you need to go to your 

notifications to download the file; or after logging in, you can click on the Download Legal Invoices button 

from your email notification again. 

Warning: The .zip file expires 30 days after you export it. After expiration you cannot download it from your 

email or online notification. 

 
 
 

A green message bar informs you that "The data you requested will be emailed to you shortly." 
 

 

There is no limitation on the number of invoices or file size when exporting legal invoices.  
 

 

Online and email notifications are on by default, so if you have not turned off your online notification for Legal Invoice 

Export Ready, you also get a notification in the CSP. For more information, see View and Manage Notifications. 
 

 

When you click on the Download Legal Invoices button in the email or on the notification in the CSP, the compressed 

file is downloaded to your device. 
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View Invoice Lines 
Click on the Invoice Lines tab to see information on the invoice lines for each invoice. 

 
From the Select Customer drop-down list in the top right corner, select the customer whose invoice lines you want to 

see. 

 

The Invoice Lines table shows the following information for all the invoice lines: 
 

Column Description 

Invoice # Invoice number generated by Coupa. Click on it to view the invoice. 

Line # Invoice line number. 

Description Invoice line description. 

Status Current status of the invoice. For more information, see View and Manage 

Invoices. 

Invoice Date Date when the invoice was created. 

PO Line # PO line number. 

Total Total amount of the invoice line. 

 
You can export the invoice lines table in CSV or Excel format. 

 
You can filter the table by columns, use the search bar to filter with a search term, or click on the View drop-down list to 

perform advanced filtering. For more information, see Create Custom Views. 

 
 
 
 

View Payment information 
 

Payment Information View 
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Note: Only if the submitted invoiced amount has been fully paid by Lear, the Paid column will turn into Yes 

Click on the Invoices tab on the main menu and select Payment Information view 

 

 

Payment Section Layout 

The Payments section layout on the invoice page, can be viewed on any invoice by going to Invoices and viewing an 

invoice in any status. 

 

 

Payments section statuses 

The payments section includes the following payment statuses: 

Payment status Details 

Pending 

document 

approval 

The invoice is currently pending approval and has not been marked as externally paid. 

There may or may not be payment reconciliation lines on the invoice at this time. 

Externally paid The invoice has been marked as paid, either through the UI or through a payments 

integration. It does not matter if the invoice is currently pending approval or not. 

Ready to pay The invoice is approved for payment, but does not yet have any payment reconciliation 

lines on it. 

Partially paid The invoice is approved for payment and has some payment details, but the invoice total 

has not yet been fully paid or over paid. 

The remaining balance is greater than 0. 
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Payment status Details 

Fully paid The invoice is approved for payment and has been reconciled to a point where the 

remaining balance is 0. 

Overpaid The invoice is approved for payment and has payment reconciliation lines that bring the 

amount due to less than 0. 

 

The columns in the Payments section 

Columns Description 

Date Payment date, which date has been paid from Lear  

Description Brief description entered by Lear AP Accountant (if necessary) 

Type “Tax” or “Payment” 

Amount Withholding tax amount associated with the submitted invoice will display in “Tax” type line;  

The amount (invoiced amount – Withholding Tax amount) actually paid from Lear will display in 

“Payment” type line. 

 

Disputed invoices 
Invoice with disputed status is disputed by Lear AP or auto disputed by the system. 

Lear will dispute (automatically) any invoice that is: 

• Invoice Date backdated more than specified calendar days 

• Does not match with the PO’s currency 

• Exceeds the PO quantity 

• Exceeds the PO unit price (For quantity based POs) 

• Exceeds the PO amount (For amount based POs) 

• Has a different Unit of Measure (UOM) than the PO line 

In case you try to submit an invoice that is exceed any of Lear’s defined above tolerance limits, you will receive a 

submission warning, in that case do not submit your invoice or it will be disputed automatically. Contact your Lear buyer if 

a PO amendment is required. 
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Tip: Country compliant e-invoices are marked with a green checkmark next to the country code in their top 

right corner. Coupa Compliant E-Invoicing Countries List 

Warning: The corrected invoice must have a new number. 

Warning: Lear does not process disputed invoices for payment until you resolve the dispute. 

Note: If Lear disputes an invoice in error, or you choose not to resolve the dispute, inform your Lear counterpart 

and Lear can withdraw the invoice from dispute and process it. 

Acting on Disputed e-Invoice 

When the status of an invoice changes to "Disputed", you receive an email notification with the invoice number, the date 

of the dispute, the reason for the dispute, and optionally any additional comments. Your customer can leave comments 

on the invoice while it is in "Disputed" status. 
 

In the Invoices table, click on the invoice number or on the Resolve        button in the Actions column for the disputed 

invoice that you want to resolve.  

 

To resolve a dispute, click on the relevant button at the bottom of the invoice. Depending on the type of invoice, you 

have the following options: 

 

Standard e-invoice 

 

• Void 

 
If an invoice was issued in duplicate or has already been paid for through an earlier invoice, void it. 

 
• Correct Invoice 

 
If an invoice has some incorrect information, correct it. When submitting a corrected invoice, you can reuse the same 

invoice number. 

 

Country compliant e-invoice 
 

 

• Cancel Invoice 
 

If an invoice was issued in duplicate, create a credit note to cancel it. 

 
If an invoice has some incorrect information (other than price or quantity), for example, incorrect tax rate or item 

description, create a credit note to cancel it and issue a new corrected invoice. The original invoice remains in 

disputed status and the corrected invoice is submitted for approval. 
 

 

• Adjust 

 
If the price and/or the quantity for invoice lines(s) is incorrect on an invoice, issue an adjustment credit note (partial 

credit) to correct it. You can adjust credit line quantity also in case of returned goods or if an invoice has already 

been paid for. 

List




Coupa Compliant E-Invoicing Countries List
Below is a list of all the compliant e-Invoicing countries that are supported in Coupa's Compliance-as-a-Service (CaaS)
and Invoice Content Validation Checks. For more information on compliance, see Compliant Invoicing.


Country Added to Release Notes


UK R16


Ireland R16


Austria R16


Germany R16


Netherlands R16


France R16


Italy R16
R22
R23


Effective January 1, 2019, the Italian government
implemented an invoice clearance regime that mandates
all domestic Italian invoices be routed through their SDI
(Sistema Di Interscambio). See Italian e-Invoicing with
SDI clearance model for more details.


R16 (Post-audit model), R22 (outbound flow for SDI
clearance model), R23 (inbound flow for SDI clearance
model)


Sweden R16


Switzerland R16


South Africa R16


USA R16


Belgium R17


Spain R17 From R21.3 Canary Islands has been added to Spain.
See Spain and Canary Islands Compliance.


Czech Republic R17 Correction invoices are not supported


Poland R17 Correction invoices are not supported


Slovakia R17


Australia R17


Singapore R17


www.coupa.com



https://success.coupa.com/@api/deki/files/10437/Coupa_Compliance-as-a-Service_for_E-Invoicing_Product_Guide_v3.0.pdf?revision=1

https://success.coupa.com/Support/Releases/Old/22/New_Features/Core_Apps/Invoicing/Spain_and_Canary_Islands_Compliance

https://www.coupa.com/





Country Added to Release Notes


Canada R18


Malta R18


Denmark R18


Finland R18


Greece R18


Norway R18


Slovenia R18


Latvia R18


Estonia R18


Lithuania R18


Bulgaria R18


Croatia R18


India R18


Japan R19


Malaysia R19


New Zealand R19


Serbia R19 No support for digital signatures and archiving.
Coupa will not create the legal invoice on behalf of the
supplier when Serbia mandates a clearance model.
Suppliers should connect to the tax authority system
outside of Coupa for clearance and legal invoice
issuance.


Romania R19


Luxembourg R19


Mexico R20 Clearance Country Model


United Arab Emirates R24


Bahrain R24 No support for digital signatures and archiving


Montenegro R24


Hong Kong R25


China R27 Invoice content checks; Coupa does not create the legal
invoice on behalf of the supplier; No support for digital
signatures and archiving. See Validation-Only Invoice
Templates for more info.


Bangladesh R28 Invoice content checks; Coupa does not create the legal
invoice on behalf of the supplier; No support for digital
signatures and archiving. See Validation-Only Invoice
Templates for more info.
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Country Added to Release Notes


Myanmar R28 Invoice content checks; Coupa does not create the legal
invoice on behalf of the supplier; No support for digital
signatures and archiving. See Validation-Only Invoice
Templates for more info.


Pakistan R28 Invoice content checks; Coupa does not create the legal
invoice on behalf of the supplier; No support for digital
signatures and archiving. See Validation-Only Invoice
Templates for more info.


Namibia R29 No support for digital signatures and archiving


Hungary R29 Invoice content checks; Coupa does not create the legal
invoice on behalf of the supplier; No support for digital
signatures and archiving. See Validation-Only Invoice
Templates for more info.


South Korea R29 Invoice content checks; Coupa does not create the legal
invoice on behalf of the supplier; No support for digital
signatures and archiving. See Validation-Only Invoice
Templates for more info.


Brazil R30 Invoice content checks; Coupa does not create the legal
invoice on behalf of the supplier; No support for digital
signatures and archiving. See Validation-Only Invoice
Templates for more info.
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